
    Add the NetWare Application Launcher to the NetWare Client 
Workstation
Purpose
The executable and DLLs for the NetWare* Application Launcher* should be installed in an 
accessible directory on the network server, such as SYS: PUBLIC. Each NetWare Client 
workstation should have a Windows program item pointing to the NetWare Application 
Launcher executable on the server.
Prerequisites
The NetWare Application Launcher help files, executables, and DLLs must reside in a 
network directory (typically PUBLIC).
Make the NetWare Application Launcher available in Windows
1. Choose or create a program group for the NetWare Application Launcher.
2. Create a program item for the NetWare Application Launcher.
3. Type or browse the path to NAL.EXE. (Alternatively, drag the NAL.EXE icon from the File 

Manager to a Program Manager group, such as NetWare Utilities or StartUp.)
A dialog box will appear, informing you that the application may not be available in other
sessions. Choose OK.

4. Choose the desired icon.
5. Choose OK.
To add the NetWare Application Launcher to a Windows 95 StartUp folder
1. Browse to NAL.EXE.
2. In a separate window, open the Windows** StartUp folder (typically C:\WINDOWS\Start 

Menu\Programs\StartUp).
3. Drag NAL.EXE to the Windows StartUp folder.
To create Windows 95 shortcut to the NetWare Application Launcher 
1. From the File menu, choose New, then choose Shortcut. 
2. For the command line, enter the path to NAL.EXE, then choose Next.
3. Enter any name you want for the shortcut, then choose Finish.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.
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    Administrating Desktops Using the NetWare Application 
Manager and NetWare Application Launcher
The situation
A NetWare* administrator of a company with 100 employees wants to distribute an 
application to the employees who need it. The application is a calculator which performs 
specific business functions unique to the company. About half the employees have duties 
which could be simplified by using the calculator.
The calculator application requires no special drive mappings, printer ports, environment 
variables, or user configuration files.
Solution #1 Using local computer resources
The administrator installs the calculator application on each user’s hard drive. This is the 
most time-intensive option; it requires the administrator to install, upgrade, and support the 
application and computer hardware at each user's location.
Solution #2 Using the network
The administrator installs the calculator on a NetWare server called PRODUCTS in the SYS:\
APPS\CALC\V1.0 directory. Using the NetWare Administrator*, the administrator creates a 
Group object called CALC GROUP. File system rights are granted to CALC GROUP in the 
directory where the application is installed. Users requiring access to the calculator 
application are made members of CALC GROUP.
Though the application is now available, since no calculator icons appear on the desktop, the
users are not aware that the calculator application is available. The administrator may 
communicate that the calculator is available and explain where the application is located 
and how to set it up, or must physically visit each desktop.
Some problems that still exist:
1. Even though the calculator icon appears on the user's workstation, the application 

resides on the network.    If the user is not logged in when the application icon is double-
clicked on the icon, an error message comes up stating that the path is invalid. Users 
may be confused by the error and require support.

2. The user may delete the icon, then need help by the administrator to restore it.
3. The icon references the executable file (CALC1.EXE) in the \\PRODUCTS\SYS\APPS\CALC\

V1.0 directory. To move or rename the executable, or upgrade to version 2.0 without 
removing version 1.0, the path must be changed at each workstation.

Solution #3 Using the NetWare Application Manager and NetWare Application 
Launcher
The administrator installs the calculator application on server PRODUCTS in the SYS\APPS\
CALC\V1.0 directory, creates CALC GROUP, and adds to the group users who need the 
application.
Using NetWare Administrator, the administrator creates an Application object called CALC1.   
The CALC1 object contains the path to the program file and other information such as 
command-line parameters, the working directory, and a description of what the application 
does.    The administrator associates CALC1 Application object with CALC GROUP.
Using the NetWare Application Launcher*, the CALC1 application icon appears on each user's
workstation. No setup is required at the user's workstation. The user can launch the 
application by double-clicking the icon.
Benefits of the NetWare Application Manager and NetWare Application Launcher:
1. Simplifies administration of network applications. The user cannot delete the application 

icon or change any of its information. 



2. Eliminates the need for login scripts. The administrator can associate working directories,
paths to executables, or other information with the Application object.

3. Simplifies user access to network applications. The users can log in to the network using 
any workstation and can still access all their applications.

4. Dynamically updates user desktops. The users are unaware of any changes if the 
administrator wants to move or rename the executable file. Only the object itself must 
be modified.

5. Eases installation and upgrades. Users can run installation programs from the NetWare 
Application Launcher, allowing them to install software such as NetWare Client* software,
productivity software, and operating systems over the network. An application can be 
upgraded by modifying the path to the new application executable, which can be 
installed anywhere on the network. 

6. Easy to install and use. Steps for installing the NetWare Application Manager are easy to 
follow and to complete. Launching the NetWare Application Launcher is as easy as 
double-clicking an icon.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Application objects can be one of the following classes:
DOS**
Windows 3.x**
Windows 95**
Windows NT**

Choose the type of class that corresponds with the application.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Related Topics
What is an Application object
Why would I use Application objects
Examples of using Application objects



Related Topics
NetWare Application Manager
NetWare Application Manager Overview



    Assign An Application to Multiple Users or Groups
Purpose
Application objects assigned to the NetWare* Application Launcher** will appear on the 
user's desktop. 
To assign an application to multiple users or groups
1. Using the NetWare Administrator*, choose the Application object from the NetWare 

Directory Services* tree.
2. Choose Details from the Object pull-down menu item.
3. Choose Associations.
4. Choose Add or Delete.
Note: Using this procedure, the administrator can only assign Application objects that will 
appear as icons for the user. An application cannot be assigned to automatically launch. See 
Assign multiple applications to a user, group, or container.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



    Assign Application Objects to a Launcher Overview
Application objects assigned to the NetWare* Application Launcher** will appear on the 
user's desktop. Applications can be assigned to users, groups, or containers.
If the application is associated with a user, the user can view and launch the application. If 
the application is associated with a group, each user in the group can view and launch the 
application. If the application is associated with a container, each user or group in the 
container can view and launch the application.
Note: Application objects may not be accessible unless they are added to the Launched by
User list.
Applications can also be designated to automatically launch when the user accesses the 
NetWare Application Launcher.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



    Assign Application Objects to Launch
Assign Application objects to launch

Overview
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    Assign Multiple Applications to a User, Group, Or Container
Purpose
Application objects assigned to the NetWare* Application Launcher* will appear on the user's
desktop. 
To assign applications to launch
1. Using the NetWare Administrator*, choose a user, group, or container object from the 

NetWare Directory Services* tree.
2. From the Object menu, choose Details.
3. Choose Applications.
4. Choose Add.
5. Choose the desired application to launch.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



The Browse button allows you to walk the Directory tree to find the appropriate file or 
directory.



    Configure the NetWare Application Launcher
Purpose
The NetWare* Application Launcher* can be configured for an organization or a User object. 
The NetWare Application Manager allows the network administrator to specify how each user
views the NetWare Application Launcher. 
To configure the NetWare Application Launcher
1. From NetWare Administrator, choose the User or container object.
2. From the Object menu, choose Details.
3. Choose Launcher Configuration from the button bar.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



    Create the Application Object
Purpose
Using the NetWare* Administrator, any Windows or DOS executable can be created as a 
NetWare Directory Service* Application object. Application objects can be managed by the 
network administrator, and made available to users running the NetWare Application 
Launcher*.
Create the Application object
1. Using the NetWare Administrator, choose a container object from the NetWare Directory 

Services tree.
2. From the Object menu, choose Create.
3. Choose the Application class.
4. Choose OK.
5. Type the Application Object name.
6. Type or browse the Path to executable file.
7. Choose Define Additional Properties.
8. Choose Create.
(Optional) Choose Environment to specify drive mappings or print captures that the 

application may require.
(Optional) Set up a contact for the application.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



    Create and Define Application Object Properties
Create and Define Application Objects

Create the Application object
Set Application object identification properties
Set up application support contacts
Set up the application environment
Manage setup and post-termination scripts



 Dynamically Updates User Desktops
With the NetWare* Application Manager, network applications delivered to Windows** 
desktops are dynamic and can be refreshed automatically. This ensures that any changes 
the administrator makes are quickly reflected on users’ desktops.
For example, if a new version of a network application is installed, the administrator can 
quickly move the appropriate users to that new version using the NetWare Application 
Manager. The administrator simply modifies the properties in the Application object defined 
in NetWare Directory Services* to point to the new version of the application. The NetWare 
Application Manager then updates that network application on the appropriate user 
desktops. The next time a user double-clicks on the icon for that application, the updated 
version is launched automatically. 

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Electronic mail correspondence is available from the NetWare Application Launcher. If the 
end user chooses the E-mail button, the contact's address is placed in an electronic mail 
message and a mail message is sent to the contact.



 Eases Installation and Upgrades
The NetWare* Application Manager makes it easy to install new applications and migrate 
users to new versions of applications without requiring the administrator to travel to each 
user’s workstation. An application can be upgraded by modifying the path to the new 
application executable, which can be installed anywhere on the network. 
The NetWare Application Launcher* makes it easy for users to install and/or upgrade their 
own NetWare Client* software, productivity software, and operating systems over the 
network. 

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Easy to Install and Use
The NetWare Application Manager consists of both an administrator component and a user 
component. The administrator component is a Windows** DLL that snaps into the NetWare* 
Administrator utility and adds new property buttons to the Details listing of the appropriate 
NetWare Directory Services* objects. This allows administrators to work from a familiar and 
consistent interface. The user component is an executable file that is run in each user’s 
Windows Startup or other program group as desired.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Eliminates the Need for Login Scripts
Because the Application objects are linked to the location of network applications, users no 
longer need drive mappings established through login scripts. Each Application object can 
also store scripts that can map additional drives and capture printers as users launch 
applications. This saves considerable administration time and costs since administrators are 
no longer required to create and manage individual network login scripts. 



 Enable NetWare Client 32 Installation from the Network 
Purpose
Follow these instructions to enable NetWare* Application Launcher* users to upgrade to 
and/or install NetWare Client 32* without assistance from the network administrator.
Prerequisites

You must have already installed the NetWare Application Launcher on a network server. 
You must    have access to an image of NetWare Client 32 on a network server. 
In NetWare Administrator, change context to the container in which the object will 
appear.

Deliver NetWare Client 32 Setup over the network using the NetWare Application 
Launcher (Windows 95)
Use the procedure to enable users to launch NetWare Client 32 Setup as a NetWare-
delivered application.
1. Create an Application object (Windows 95**).
2.  Set the Path to executable file for NetWare Client 32 Setup to the location of 

SETUP.EXE on the network server, such as \\GT\CLIENT 32\WIN95\SETUP.EXE.
3. (Optional) Enter a description and/or contact information.
4. Associate the Application object with a container, Group, or User object. 
Deliver NetWare Client 32 Setup over the network using the NetWare Application 
Launcher (Windows 3.x)
Use the procedure to enable users to launch NetWare Client 32 Setup as a NetWare-
delivered application.
1. Create an Application object (Windows 3.x**).
2.  Set the Path to executable file for NetWare Client 32 Setup to the location of 

SETUP.EXE on the network server, such as \\GT\CLIENT 32\WIN3X\SETUP.EXE.
3. (Optional) Enter a description and/or contact information.
4. Associate the Application object with a container, Group, or User object. 

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



    Enable Lotus Notes installation from the network
Purpose
Follow these instructions to enable NetWare* Application Launcher users to install and run 
Lotus Notes without assistance from the network administrator.
Prerequisites

You must have already installed the NetWare Application Launcher on a network server. 
You must have access to an image of Lotus Notes** on a network server. 
In NetWare Administrator, change context to the container in which the object will 
appear.

Deliver Lotus Notes Installation over the network using the NetWare Application 
Launcher
Use the procedure to enable users to launch Lotus Notes Installation as a NetWare-delivered 
application.
1. Create an Application object (Windows 3.x).
2. Set the Drive mappings as a root mapping to the location of instwin.exe on the 

application server, such as P:=\\PRV-IS-SRVS\SYS\STATAPP\LOTUS\NOTES\NOTES.33\
WORKSTA\WINDOWS.

3.  Set the Path to executable file for Lotus Notes Installation to the location of 
instwin.exe on the network server, such as P:\INSTWIN.EXE.

4. Set the Working directory to the same directory that instwin.exe is located in, such as 
p:.

5. Set Clean up resources to OFF.
6. (Optional) Enter a description and/or contact information.
7. Associate the Application object with a container, Group, or User object. 
Deliver Lotus Notes over the network using the NetWare Application Launcher
Use the procedure to deliver Lotus Notes.
1. Create an Application object (Windows 3.x).
2. Set the Path to executable file to the location of the application executable on the 

network server, such as P:/NOTES.EXE.
3. Set the Working directory to the same directory that instwin.exe is located in, such as 

P:.
4. (Optional) Enter a description and/or contact information.
5. Associate the Application object with a container, Group, or User object. 

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Enable NetWare Client 32 installation from the network 
Purpose
Follow these instructions to enable NetWare* Application Launcher* users to upgrade to 
and/or install NetWare Client 32* without assistance from the network administrator.
Prerequisites

You must have already installed NetWare Application Launcher on a network server. 
You must    have access to an image of Client 32 on a network server. 
In NetWare Administrator, change context to the container in which the object will 
appear.

Deliver Client32 Setup over the Network using NetWare Application Launcher 
(Windows 95)
Use the procedure to enable users to launch Client 32 Setup as a NetWare-delivered 
application.
1. Create an Application object (Windows 95**).
2.  Set the Path to executable file for Client 32 Setup to the location of SETUP.EXE on the 

network server, such as \\ATM\CLIENT32\WIN95\SETUP.EXE.
3. (Optional) Enter a description and/or contact info.
4. Associate the Application object with a container, Group, or User. 
Deliver Client32 Setup over the Network using NetWare Application Launcher 
(Windows 3.x)
Use the procedure to enable users to launch Client32 Setup as a NetWare-delivered 
application.
1. Create an Application object (Windows 3.x**).
2.  Set the Path to executable file for Client32 Setup to the location of SETUP.EXE on the 

network server, such as \\ATM\CLIENT32\WIN3X\SETUP.EXE.
3. (Optional) Enter a description and/or contact info.
4. Associate the Application object with a container, Group, or User. 

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Enable PerfectOffice Installation from the Network
Purpose
Follow these instructions to enable NetWare* Application Launcher* users to run 
PerfectOffice* Setup and install PerfectOffice* applications without assistance from the 
network administrator.
Prerequisites

You must have already installed the NetWare Application Launcher on a network server. 
You must have access to an image of PerfectOffice on a network server. 
In NetWare Administrator, change context to the container in which the object will 
appear.

Deliver PerfectOffice Setup over the network using the NetWare Application 
Launcher
Use the procedure to enable users to launch PerfectOffice Setup as a NetWare-delivered 
application.
1. Create an Application object (Windows 3.x).
2.  Set the Path to executable file for PerfectOffice Setup to the location of SETUP.EXE on 

the network server, such as \\NAL\APPS\WIN\OFFICE\SHARED\SETUP.EXE.
3. Set the Working directory to the same directory that SETUP.EXE is located in, such as \\

NAL\APPS\WIN\OFFICE\SHARED\SETUP.EXE.
4. (Optional) Enter a description and/or contact information.
5. Associate the Application object with a container, Group, or User object. 
Deliver PerfectOffice Applications over the network using the NetWare Application
Launcher
Use the procedure to deliver PerfectOffice applications such as Envoy* (ENVOY.EXE), 
InfoCentral* (WPIC.EXE), Presentations* (PRWIN.EXE), Quattro Pro* (QPW.EXE), and 
WordPerfect* (WPWIN.EXE).
1. Create an Application object (Windows 3.x**).
2. Set the Path to executable file to the location of the application executable on the 

network server.
\\NAL\APPS\WIN\OFFICE\WPIC\WPIC.EXE
\\NAL\APPS\WIN\OFFICE\PRWIN\PRWIN.EXE
\\NAL\APPS\WIN\OFFICE\QPW\QPW.EXE
\\NAL\APPS\WIN\OFFICE\WPWIN\WPWIN.EXE

3. Set the Working directory for Envoy to \\NAL\APPS\WIN\OFFICE\ENVOY\ENDOCS and for
InfoCentral to \\NAL\APPS\WIN\OFFICE\WPIC\LOCAL.

4. (Optional) Enter a description and/or contact information.
5. Associate the Application object with a container, Group, or User object. 

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Enable GroupWise Installation from the Network
Purpose
Follow these instructions to enable NetWare* Application Launcher* users to run GroupWise*
Setup and install and run GroupWise without assistance from the network administrator.
Prerequisites

You must have already installed the NetWare Application Launcher on a network server. 
You must have access to an image of GroupWise on a network server. 
In NetWare Administrator, change context to the container in which the object will 
appear.

Deliver GroupWise Setup over the network using the NetWare Application 
Launcher
Use the procedure to enable users to launch GroupWise Setup as a NetWare-delivered 
application.
1. Create an Application object (Windows 3.x**).
2.  Set the Path to executable file for GroupWise Setup to the location of SETUP.EXE on 

the network server, such as \\MAILSERVER\SYS\PO\SETUPWIN.EXE.
3. Set the Working directory to the same directory that SETUP.EXE is located in, such as \\

NAL\APPS\WIN\OFFICE\SHARED\SETUP.EXE.
4. (Optional) Enter a description and/or contact information.
5. Associate the Application object with a container, Group, or User object. 
Deliver GroupWise over the network using the NetWare Application Launcher
Use the procedure to deliver GroupWise. The procedure uses the PerfectOffice* shared code 
located on an application server.
1. Create an Application object (Windows 3.x).
2. Set the Path to executable file to the location of the application executable on the 

network server, such as \\MAILSERVER\SYS\PO\OFWIN40\OFWIN.EXE.
3. Set the Command Line properties to include a shell variable for the username, as well 

as to the location of the PerfectOffice Shared code on the network, such as    /@U-’%FULL 
NAME%’ /WPC-W:\WIN\OFFICE\SHARED\WPC20 /PH-X:\PO.

4. Set the Working directory to the directory in which the GroupWise post office resides, 
such as \\MAILSERVER\SYS\PO\OFWIN40.

5. Set the Drive mappings to the NetWare volumes where the GroupWise application and 
post office reside, such as W:=APPSERVER/APPS: and X:=MAILSERVER/SYS:\PO.

6. (Optional) Enter a description and/or contact information.
7. Associate the Application object with a container, Group, or User object. 

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Enable MS Office Installation over the Network
Purpose
Follow these instructions to enable NetWare* Application Launcher* users to install and run 
MS Office** without assistance from the network administrator.
Prerequisites

You must have already installed the NetWare Application Launcher on a network server.
In NetWare Administrator, change context to the container in which the object will 
appear.
You must have already installed MS Office on a network server. MS Office Setup installs 
utilities on the workstation hard drive, and the NetWare Application Launcher prohibits 
the network administrator    from creating an Application object without access to the 
Application object’s executable. 
Note: The procedures have been verified using the following MS Office options:

user’s access by server name
user’s choice for shared files.

Deliver MS Office Setup over the network using the NetWare Application Launcher
Use the procedure to enable users to launch MS Office Setup as a NetWare-delivered 
application.
1. Create an Application object (Windows 3.x**).
2.  Set the Path to executable file for MS Office Setup to the location of SETUP.EXE on the 

network server, such as \\NAL\APPS\WIN\MSOFFICE\SETUP.EXE.
3. (Optional) Enter a description and/or contact information.
4. Associate the Application object with a container, Group, or User object. 
Deliver MS Office utilities icons over the network using the NetWare Application 
Launcher
Use the procedures to deliver icons for MS Office utilities Binder (BINDER.EXE), File New ),    
File Open (MSOW.EXE), and Shortcut Bar** (MSOFFICE.EXE). 
Note: MS Office requires the utilities to reside in a directory on the workstation hard drive. 
This procedure creates NetWare Application Launcher icons that reference utilities on the 
user's workstation.
1. Create an Application object (Windows 3.x).
2. Set the Path to executable file to the location of the application executables on the 

local workstation.
C:\MSOFFICE\OFFICE\BINDER.EXE
C:\MSOFFICE\OFFICE\MSOW.EXE
C:\MSOFFICE\OFFICE\MSOW.EXE
C:\MSOFFICE\OFFICE\MSOFFICE.EXE

3. Set the Command line options for File New to -N and File Open to -F. 
4. (Optional) Enter a description and/or contact information.
5. Associate the Application object with a container, Group, or User object. 
Deliver MS Office applications over the Network using the NetWare Application 
Launcher
Use the procedure to deliver MS Office applications Excel** (EXCEL.EXE), PowerPoint** 



(POWERPNT.EXE), Schedule+** (SCHDPL32.EXE), and Word** (WINWORD.EXE).
1. Create an Application object (Windows 3.x).
2. Set the Path to executable file to the location of the application executables on the 

network server.
\\NAL\APPS\WIN\MSOFFICE\EXCEL\EXCEL.EXE
\\NAL\APPS\WIN\MSOFFICE\POWERPNT\POWERPNT.EXE
\\NAL\APPS\WIN\MSOFFICE\SCHEDULE\SCHDPL32.EXE
\\NAL\APPS\WIN\MSOFFICE\WINWORD\WINWORD.EXE

3. (Optional) Enter a description and/or contact information.
4. Associate the Application object with a container, Group, or User object. 
Note: MS PowerPoint produces an error that it can not find an INI file. The error message 
indicates that you must run MS PowerPoint setup. PowerPoint still runs without the INI file.
Note: MS Word requires SDM.DLL in WINDOWS\SYSTEM. Copy this file or use the startup 
script to do this function.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Enable Windows 95 Installation from the Network
Purpose
Using the NetWare* Application Launcher*, you can upgrade every workstation to Windows 
95**.
To install Windows 95 from the network:
1. Create an Application object of type Application (Windows 3.x**).
2. Set the Path to executable file to SETUP.EXE in the root of Windows 95.

For example, mount the Windows 95 CD as a volume on the server GT.    Enter the path \\
GT\WINDOWS95\SETUP.EXE.    If you copied the CD to a server, rather than mounted it as 
a volume, change the path to point to SETUP.EXE.

3. Set the Working directory to the same directory that SETUP.EXE is located in (\\GT\
WINDOWS95).

4. (Optional) Enter a description and/or contact information.
Note:    Windows 95 needs access to the install CD if the user changes configuration and/or 
installs NetWare Client 32*.    Users can be told where the install CD is on the network, so if 
they are prompted for it, they can enter the path.    (You could put this info in the long 
description.)

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 For More Information
In the United States and Canada, call 1-800-NETWARE (1-800-638-9273). In all other 
locations, call 
1-801-429-5588.



 Frequently Asked Questions and Answers
Listed below are the most commonly asked questions about the NetWare* Application 
Launcher* and the NetWare Application Manager.
Q: What does the NetWare Application Launcher do when a drive it needs to 
map is already mapped?
A: If an application needs a drive that is already mapped and that drive is mapped to 
the correct place, it will use the existing drive mapping.    If the drive is not already mapped 
to the right place, the launch will fail, and the NetWare Application Launcher will display an 
error message that describes the resource conflict. The user can manually unmap the 
needed drive and relaunch the application. The NetWare Application Launcher will not 
override an existing mapping.    Most applications will crash, hang, or malfunction if drive 
mappings that they are dependent on change.    Because of this, the NetWare Application 
Launcher will not override an existing drive mapping.
Q: How does the NetWare Application Launcher handle local configuration files
like INI files and registry settings?
A: The NetWare Application Launcher provides a mechanism called the prelaunch script.
This prelaunch script is where you enter any workstation configuration commands that need 
to take place.    There is also a post-termination script. This post-termination script is run 
after the NetWare Application Launcher detects that the application has terminated.    Like 
the prelaunch script, this script follows the login script language syntax.    Commands for 
cleaning up the changes made by the prelaunch script should be placed in the post-
termination script.
Q: What workstation software is needed in order to run the NetWare 
Application Launcher?
A: You must use a NetWare client that supports NetWare Directory Services.    On 
DOS/Windows** 3.x, use VLM* files or NetWare Client 32.    On Windows 95**, use NetWare 
Client 32.
Q: What files are needed in order to run the NetWare Application Launcher?
A: A Windows 3.x user should use NAL.EXE, NALW31.EXE, NALRES.DLL, NALBMP.DLL, 
and NAL.HLP.    A Windows 95 user should use NAL.EXE, NALW95.EXE, NALRES32.DLL, 
NALBMP32.DLL, and NAL.HLP. A Windows 3.x or Windows 95 administrator should use 
APPSNAP.DLL and APPSNAP.HLP, in addition to the Windows 3.x files specified in Install the 
NetWare Application Launcher--Overview.
Q: When will there be OS/2 and Windows NT versions of the NetWare 
Application Launcher?
A: A Windows NT** version of the NetWare Application Launcher is currently in 
development.    An OS/2** version of the NetWare Application Launcher is being investigated.
Q: What is the syntax for drive mappings in the NetWare Application 
Launcher?
A: Syntax for mapping a drive:
SERVER\VOLUME:PATH
\\SERVER\VOLUME\PATH
VOLUME_OBJECT_NAME:PATH
DIRECTORY_MAP_OBJECT_NAME:PATH
Syntax for capturing a port:
SERVER\DS_QUEUE_NAME:
\\SERVER\DS_QUEUE_NAME
DS_QUEUE_NAME



\\\DS_QUEUE_NAME
Q: Does the NetWare Application Launcher support bindery servers?
A: No. Since the NetWare Application Launcher relies on NetWare Directory Services for 
its functionality, it does not support bindery servers.
Q: Do I have to use Novell’s NetWare Client 32 in Windows 95?
A: The NetWare Application Launcher for Windows 95 requires NetWare Client 32.    
NetWare Application Launcher for Windows 95 is a Win32 application that uses the NetWare 
32-bit libraries that require NetWare Client 32.    You can use NetWare Application Launcher 
for Windows 3.1x in Windows 95.    It is a 16-bit application that can make 16-bit calls 
through VLMs or NetWare Client 32.
Q: Does the NetWare Application Launcher support 16-bit Directory Map 
objects?
A: The NetWare Application Launcher supports directory map objects, as well as aliases 
to them in the EXE path, working directory, and drive mapping strings.
Q: How does the NetWare Application Launcher figure out what icons to show?
A: The NetWare Application Launcher builds a view of icons based on Application object 
associations in NetWare Directory Services.    First, the NetWare Application Launcher checks 
the current User object for any Application objects associated with that user and adds them 
to the list.    Next, the NetWare Application Launcher checks every Group object of which the 
user is a member for Application object associations, then adds them to the list.    Finally, the
NetWare Application Launcher checks parent containers, depending on the ‘container levels’
setting for Application object associations and adds them to the list.    Once the list is built, 
the NetWare Application Launcher filters all duplicates and filters Application objects it 
cannot run.    For instance, the NetWare Application Launcher for Windows 3.1x will filter out 
all Windows 95 Application objects.    Once the list has been filtered, the icons are displayed 
to the user.
Q: Right now, I can only choose icons from the EXE file defined with the 
Application object. Is there a way to choose icons from a file other than the EXE 
like in Program Manager?
A: Currently, you can only choose from the icons in the EXE the Application object points
to.    In the future this feature will be added.
Q: I have too many icons in my main view and would like a way of filtering 
them.    Will the NetWare Application Launcher support a group or folder view in 
the future?
A: Yes.    In the future the NetWare Application Launcher will support folder or group 
types of views.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



The Full Path to the executable may be typed in either as a UNC path or a file directory 
path. You can also use the browse button to walk through the file directory structure to find 
the desired executable.



Syntax for Mapping a Drive
\\SERVER\VOLUME:PATH
\\SERVER\VOLUME\PATH
VOLUME_OBJECT_NAME:PATH
DIRECTORY_MAP_OBJECT_NAME:PATH



Syntax for Capturing a Port
SERVER\DS_QUEUE_NAME:
\\SERVER\DS_QUEUE_NAME
DS_QUEUE_NAME
\\\DS_QUEUE_NAME



 Help--Application Associations
Purpose
Displays User, Group, or container objects that can launch the Application object.
Screen options
Add a User, Group or container object to provide access to the Application object.
Delete a User, Group or container object to remove access to the Application object.



 Help--Application Contacts
Purpose
Assigns support contacts to specific Application objects. This assignment appears in the 
NetWare* Application Launcher* in Properties.
Screen options
A list of people displays all users assigned as support contacts.
Add an additional User object as a support contact.
Delete a User object as a support contact.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Help--Application Description
Purpose
Describes to users unfamiliar with an Application object the services it provides.



 Help--Application Drives/Ports
Purpose
Allows the network administrator to map drives and capture ports and network printers for 
Application objects.
Drive options
Option sets the type of drive mapping for the application. A drive mapping can be a 
standard drive letter, a root drive, or the next available drive letter.
Path is the UNC path for the application.
Drive sets the drive letter for the application.
Drive mappings are required for some applications that look for files on predetermined 
drives. Example
Port options
Capture Flags allow the network administrator to set the port capture flags of an 
Application object.
Port is the printer port on the client workstation that the Application object captures.
Queue is the NetWare* printer queue for the application. The queue can be redirected for 
applications and users who prefer to print to a specific printer. Example

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Help--Application Environment
Purpose
Identifies the environment that may be required for an Application object.
Screen options
Command line parameters are required to run some applications in a desired mode or 
view.
The Working directory can be designated for any Application object.
Run minimized minimizes the application window when launched.
Clean up network resources removes the drive mappings and printer ports associated 
with the last launched application. (If this checkbox is not checked, then drive mappings and
port captures established earlier remain in effect.)
Note: If the application does not have available mappings after launching, you may be 
running a wrapper. Unchecking Clean up network resources may eliminate this problem.



 Help--Application Identification
Purpose
Identifies the specific properties of an Application object.
Screen options
Application Icon title appears under the icon in the NetWare* Application Launcher* and 
defaults to the Application Object name. The description can be different than the 
Application Object name. It can contain periods and other special characters.
The Path to executable file may be typed in, either as a UNC path or a file directory path, 
or use the browse button to browse the file directory structure to find the desired 
executable.
Change Icon allows an icon to be assigned to the Application object. The icon appears in 
the NetWare Application Launcher.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Help--Application Objects
Purpose
Displays Application objects available to a user. These objects are assigned explicitly to the 
user and/or inherited from the user's container object, and are displayed using the context 
of the Application objects. 
Applications assigned explicitly to the user are displayed with the User object icon.
Applications inherited from a group are displayed with the Group object icon.
Applications inherited from the user's container are displayed with the Container object icon.



 Help--Application Scripts
Purpose
Scripts enable network administrators to set the network conditions under which an 
application launches and/or exits. With scripts, the administrator can map a drive or set a 
queue that an application may need.
Screen options
Run before launching
Run after termination



 Help--Create Application Object
Purpose
Windows 95**, Windows**, and DOS** executables can be created as an NetWare* Directory 
Services* Application object.
Screen options

The Application object name will display in the NetWare Directory Services tree. The 
name is limited to 64 characters and cannot contain periods or other special characters.
The Path to executable file can be typed in either as a UNC path or file directory path. 
Also, you can use the browse button to walk through the file directory structure to find 
the desired executable.
Define Additional Properties allows you to define the identification, contacts, 
environments, options, scripts, and view associations of the Application object. You may 
later define additional properties by selecting the Application object and choosing 
Details from the Object menu. 
Create Another Application allows you to create several Application objects. After 
specifying the name and the path of the Application object, you will return to the Create 
Application dialog box. Later, you can define additional properties of applications by 
choosing the Details of the Application object in the Directory tree.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Related Topics
Create the Application object
NetWare Application Manager



 Help--Desktop Application List
Purpose
Displays Application objects associated with the chosen User object.
Screen options
Applications in Launched by user are available in the NetWare* Application Launcher* and 
will launch when double-clicked.
Applications in Launched automatically will be run when launching the NetWare 
Application Launcher.
Add associates an Application object with the chosen user.
Delete removes an association of an Application object with the chosen user.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Related Topics
Set up the application environment



Related Topics
NetWare Application Manager



 Help--Launcher Configuration
Purpose
The NetWare* Application Manager allows the network administrator to specify how each 
user    views the NetWare Application Launcher*. The NetWare Application Launcher can be 
customized for an organization or a User object.
Container Options
Use default settings displays the default settings of the NetWare Application Launcher 
configuration. 
Note: When User parent container settings are chosen, the grayed-out current settings do 
not necessarily reflect the actual values of the NetWare Application Launcher configuration. 
Exit the launcher enables the user to exit the NetWare Application Launcher.
Log in/log out enables the user to login to the network from the NetWare Application 
Launcher.
Refresh icons enables the user to refresh the NetWare Application Launcher window 
manually. This displays any Application objects that were delivered since the NetWare 
Application Launcher window was last refreshed.
Move icons to the desktop (Windows 3.1x** only).
Save window size and position on local drive.
Enable timed refresh allows the network administrator    to set the number of seconds 
between automatic refreshes of the NetWare Application Launcher window.
Inherit container applications causes the User object to inherit the Application objects of 
its parent, up to a level in the directory tree chosen by the administrator.
User Object Options
Use parent container settings uses the options set for its Container object. Unchecking 
this checkbox will enable the Administrator to customize a User object's NetWare Application
Launcher settings.
Display application launched By User... displays NetWare-delivered Application objects that 
the user can launch from the NetWare Application Launcher window.
Display application launched Automatically... displays Application objects that launch 
automatically when the NetWare Application Launcher launches

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Help--Set Capture Flags
Purpose
Allows the network administrator to set the port capture flags of an Application object. 
Setting capture flags
To set Capture flags for an Application object:
1. Browse the Application object.
2. Choose Drives/Ports.
3. Choose a port and assign it an LPT and a queue.
4. Choose Set... This will bring up the Set Capture Flags dialog box.
5. In the Set Capture Flags dialog box, check the Override workstation setting column

for the corresponding Capture setting you wish to override. Once you have done this, 
the corresponding Capture setting will become active.
For example, if you check the Override workstation setting flag for Notify and also 
check the Capture setting checkbox for Notify, when the user prints a document using 
that Application object, NetWare will display a Notify alert panel to indicate the 
completion of the print job. NetWare will do this no matter which Capture settings are on 
the user's workstation.
However, if you check the Override workstation setting flag for Notify but do not 
check the Capture setting checkbox for Notify, then when the user prints a document 
using that Application object, NetWare will not display a Notify alert panel to indicate the 
completion of the print job. NetWare will do this no matter which Capture settings are on 
the user's workstation.

Note: The default capture flags of an Application object are those of the user's workstation.  
Override workstation setting
Notify overrides the Notify capture flag using the corresponding Capture setting. When 
checked, the Notify capture flag becomes active.
Banner overrides the Banner capture flag using the corresponding Capture setting. When 
checked, the Banner capture flag becomes active.
Form Feed overrides the Form Feed capture flag using the corresponding Capture setting. 
When checked, the Form Feed capture flag becomes active.
Capture setting
Notify toggles the Notify capture flag.
Banner toggles the Banner capture flag.
Form Feed toggles the Form Feed capture flag.



 Set Application Object Identification Properties
Purpose
Application objects are identified by description, name, path, and icon.
View or change the Identification properties of an Application object
1. Using the NetWare* Administrator, choose the Application object from the NetWare 

Directory Services* tree.
2. From the Object menu, choose Details.
3. Choose Identification.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Install the Application Object Software
Get started

Overview
Install the Application object software 
Modify directory schema



 Install the NetWare Application Launcher Software
Purpose
Install NetWare* Application Launcher* on the network to make Application objects available 
to users.
Install the NetWare Application Launcher software (Windows 95**)
1. Copy NAL.EXE and NALW95.EXE to a directory that is accessible by all users (such as the 

PUBLIC directory).
2. Copy NALRES32.DLL, NALBMP32.DLL, and NAL.HLP to a directory accessible by all users 

(such as the PUBLIC directory).
Note:    NALRES32.DLL, NALBMP32.DLL, and NAL.HLP can be either in the NAL.EXE 
directory, or in the NLS\<language> directory.

3. (Optional) Add NAL.EXE to the Windows Startup folder.
Install the NetWare Application Launcher software (Windows 3.1x)
1. Copy NAL.EXE and NALW31.EXE to a directory that is accessible by all users (such as the 

PUBLIC directory).
2. Copy NALRES.DLL, NALBMP.DLL, and NAL.HLP to a directory that is accessible by all users

(such as the PUBLIC directory). 
Note: NALRES.DLL NALBMP.DLL, and NAL.HLP can be either in the NAL.EXE directory or 
in the NLS\<language> directory.

3. Copy the ???WIN16.DLL files to a directory called NALLIB below NAL.EXE. For example, if 
NAL.EXE is in PUBLIC, copy ???WIN16.DLL to PUBLIC\NALLIB.

4. (Optional) Add NAL.EXE to the Windows** Startup group.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Install the NetWare Application Manager--Overview
The following files make up the NetWare* Application Launcher*:

APPSNAP.DLL
APPRES16.DLL
APPSNAP.HLP
NAL.EXE
NALW95.EXE        (Windows 95 only**)
NALW31.EXE        (Windows 3.1 only**)
NALRES32.DLL    (Windows 95 only)
NALRES.DLL        (Window 3.1 only)
NALBMP32.DLL    (Windows 95 only)
NALBMP.DLL        (Windows 3.1 only)
NAL.HLP

(Administrators use NetWare Administrator and the APPSNAP.DLL snap-in. Users run
NAL.EXE on all platforms.)
The NetWare Application Launcher requires the following files to run on Windows 3.1:

CALWIN16.DLL
CLNWIN16.DLL
CLXWIN16.DLL
LOCWIN16.DLL
NCPWIN16.DLL
NETWIN16.DLL
AUDWIN16.DLL (not part of NetWare Client 32* install)

Manual installation is done in two parts:

PART 1--Administrator Installing APPSNAP.DLL 
1. Copy APPSNAP.DLL to any directory on the network or local drive that the network 

administrator has access to. This file is typically copied to a server into the SYS:PUBLIC 
directory.

2. Copy APPRES16.DLL and APPSNAP.HLP to a directory that is accessible by the 
administrator (such as the PUBLIC directory). Note that these files can either be in the 
APPSNAP.DLL directory, or in the NLS\<language> directory below APPSNAP.DLL.

3. Edit NWADMIN.INI (found in the Windows directory). Under the "[Snapin Object DLLs]," 
add the following line: 

<snapin name>=<path>
where <snapin name> is a unique identifying name (like "SNAPIN1"), and <path> is the 
path where the APPSNAP.DLL is located (like "\\GT\SYS\PUBLIC\APPSNAP.DLL").
For example: 



[Snapin Object DLLs] SNAPIN1 = \\GT\SYS\PUBLIC\APPSNAP.DLL

4. Run NetWare Administrator. If the tree doesn't have the necessary extensions already, 
you will be prompted to modify the tree's schema.

PART 2--Installing the NetWare Application Launcher
Windows 95

1. Copy NAL.EXE and NALW95.EXE to a directory that is accessible by all users (such as the 
PUBLIC directory).

2. Copy NALRES32.DLL, NALBMP32.DLL, and NAL.HLP to a directory that is accessible by all 
users (such as the PUBLIC directory). Note that NALRES32.DLL NALBMP32.DLL, and 
NAL.HLP can be either in the NAL.EXE directory, or in the NLS\<language> directory.

3. (Optional) Add the NAL.EXE application to the Windows Startup folder
Windows 3.1 

1. Copy NAL.EXE and NALW31.EXE to a directory that is accessible by all users (such as the 
PUBLIC directory).

2. Copy NALRES.DLL, NALBMP.DLL, and NAL.HLP to a directory that is accessible by all users
(such as the PUBLIC directory). Note that NALRES.DLL NALBMP.DLL, and NAL.HLP can be 
either in the NAL.EXE directory, or in the NLS\<language> directory.

3. Copy the WIN16.DLL files to a directory called NALLIB below NAL.EXE. For example, if 
NAL.EXE is in PUBLIC, copy ???WIN16.DLL to PUBLIC\NALLIB.

4. (Optional) Add the NAL.EXE application to the Windows Startup group.
Adding the NetWare Application Launcher to Startup folder (Windows 95)
1. Browse to the StartUp folder. Starting with My Computer, browse to the directory where 

Windows 95 was installed, usually C:\WINDOWS. Continue browsing to Start Menu\
Programs\StartUp.

2. Create a shortcut to NAL.EXE. From the File menu, choose New, then choose the 
Shortcut menu item. For the command line enter the path to NAL.EXE, then choose 
Next. Enter any name you want for the shortcut, then choose Finish.

Adding the NetWare Application Launcher to Startup group (Windows 3.1)
1. Choose StartUp group in Program Manager.
2. Create a program item for NAL.EXE. From the File menu, choose New, then Program 

Item. For the command line enter the path to NAL.EXE. Enter any description if wanted. 
Choose OK.

Replacing Program Manager with the NetWare Application Launcher (Running the 
NetWare Application Launcher as the shell in Windows 3.1)
1. Copy the ???WIN16.DLL files to the WINDOWS\SYSTEM directory.
2. Copy the following files to a directory on the local drive: 

NALW31.EXE
NALRES.DLL
NALBMP.DLL
NAL.HLP



3. Edit SYSTEM.INI to set NAL as the shell. Find the line in the [boot] section that starts with 
shell=, such as 

SHELL=PROGMAN.EXE
Replace the current setting with 

SHELL=C:\NAL\NALW31.EXE
(if you placed the NAL files in C:\NAL). Save the changes and start Windows.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Install the Application object software
Purpose
Extends the NetWare* Directory Services* schema to include Application objects. Once 
extended, the network administrator can create and manage Application objects.
To install the Application object software
1. Copy APPSNAP.DLL to an accessible network or local directory.

Hint: Copy the file on the network to SYS:PUBLIC.
2. Copy APPRES16.DLL and APPSNAP.HLP to an accessible network or local directory.

Hint: Copy the files to the directory where you placed APPSNAP.DLL, or in the NLS\
(language) directory below APPSNAP.DLL.

3. Edit NWADMIN.INI (found in the Windows directory on the local workstation). Under the 
[Snapin Object DLLs] add the following line:
<snapin name>=<path>
where <snapin name> is a unique identifying name (like "SNAPIN1"), and <path> is the 
path where the APPSNAP.DLL is located (like "\\GT\SYS\PUBLIC\APPSNAP.DLL").
For example:

[Snapin Object DLLs] 
SNAPIN1 = \\GT\SYS\PUBLIC\APPSNAP.DLL

Note: The NWADMIN.INI needs to be modified on each machine that will run the NetWare
Administrator.

4. Run NWADMIN.EXE. If the tree doesn't have the necessary extensions already, you will be
prompted to modify the schema.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Manage Prelaunch and Post-termination Scripts
Purpose
Scripts can automatically be executed each time the application is launched and closed. 
Unlike the environment parameters, the setup and exit scripts can overwrite existing drive 
mappings and printer ports.

Prelaunch scripts are executed after the environment is set and before the application 
is launched.
Post-termination scripts are executed before the network resources are cleaned up 
and after the application is closed.

Manage setup and post-termination scripts
1. Using the NetWare* Administrator, choose the Application object from the NetWare 

Directory Services* tree.
2. From the Object menu, choose Details, then choose Scripts.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks



 Modify Directory Schema to Include Application Objects
Purpose
The schema that shipped with NetWare* 4.1 must be modified to include the attributes 
required to create and manage Application objects.
Modify the schema
Prerequisite: You must have administrative rights at the root of the NetWare Directory 
Services* tree.
1. Install the Application object software (APPSNAP.DLL) into the directory with the 

NetWare Administrator.
2. Start the NetWare Administrator.
3. Choose OK when asked if you want to modify the schema to accept Application objects.
The additional attributes are now available for creating and using Application objects.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 NetWare Application Launcher Overview
The NetWare* Application Launcher* allows users to run applications that were previously 
configured by a system administrator, and whose setup information is stored as an 
Application object in the NetWare Directory Services* tree.    Network Application Launcher 
displays icons for all available applications in a window, and lets the user double-click an 
icon to launch an application.
Users don't need to worry about drive mappings, paths, or rights.    The administrator can 
manage the application launcher by container, Group, or User object.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Related Topics
NetWare Application Manager



 NetWare Application Manager
Overview

Overview of NetWare Application Manager
Suggested reading

Get started
Prerequisites
Set up and use the NetWare Application Manager

Set up Application objects
Overview
Install the Application object software
Create and define Application object properties
Assign Application objects to launch

Set up the NetWare Application Launcher
Overview
Install the NetWare Application Launcher software
Configure the NetWare Application Launcher
Add the NetWare Application Launcher to the NetWare Client Workstation

Use the NetWare Application Launcher
Overview
Enable NetWare Client 32 installation from the network
Enable PerfectOffice installation from the network
Enable GroupWise installation from the network
Enable Lotus Notes installation from the network
Enable MS Office installation from the network
Enable Windows 95 installation from the network

Reference
Frequently asked questions & answers
Glossary
View README file
Trademarks and disclaimer



An application requires a drive mapped to drive S: and uses a specific printer on the 
network. The user needs no prior mappings or capture statements. When the Application 
object is launched, the launcher configures the application requirements by transparently 
mapping drive S: to the desired directory and capturing the desired printer. When exiting the
application, the printer and S: are returned to their pre-launch configuration.
Note: If S: is already mapped to a resource prior to launching the application, drive S: will 
not be mapped. An error will be returned stating that the resource is already in use.



 Overview of NetWare Application Manager
Overview

What is the NetWare Application Launcher?
What is the NetWare Application Manager?
Examples of NetWare Application Management
Software and hardware requirements
For more information

Benefits
Simplifies administration of network applications
Eliminates the need for login scripts
Simplifies user access to network applications
Dynamically updates user desktops
Eases installation and upgrades
Easy to install and use



 Overview of Creating an Application Object          
Install the software
The Application object software should be copied to an accessible network or local directory. 
The [Snapin DLLs] section of NWADMIN.INI must be edited to include the name and path of 
APPSNAP.DLL.
Modify the schema
After the Application object software has been installed, you will be prompted to modify the 
schema. Modifying the schema to include the working directory, printer ports, drive 
mappings, and other attributes will allow creation and use of Application objects.
Create the Application object
Application objects are created using NetWare* Administrator.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Overview of using the NetWare Application Launcher
Overview
The NetWare* Application Launcher* allows users to install and run software, including 
NetWare Client 32*, PerfectOffice*, Lotus Notes**, Microsoft Office*, and Windows 95*. The 
network administrator can configure SETUP.EXE or INSTALL.EXE as an Application object. 
Also, once installed, the network administrator can configure any required properties for the 
application to run normally, such as working directories and command line properties.
Prerequisites
APPSNAP.DLL must be installed in the directory with NWADMIN.EXE.
NWADMIN.INI must include the path to the APPSNAP.DLL. See Install the Application object 
software.
Set up an application or installation program
1. Create an Application object for the appropriate operating system.
2. Set any properties for the Application object, such as a specific path to the executable 
file, drive mapping, or working directory.
3. (Optional) Enter description and/or contact information.
4. Associate the Application object with a container, Group, or User object.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Prerequisites
Creating Application objects that use the NetWare* Application Launcher* requires the 
following:

NetWare 4.x with a NetWare Directory Services* tree
NetWare Administrator 4.10.2
Windows 3.1x** or Windows 95**
Administrative rights
Modification rights at the root of your tree if your schema has not been modified.
NetWare Client 32 or VLM files (NETX is not supported)

Note: The NetWare Application Launcher and Application objects will not work with a 
bindery attachment.

NetWare Application Launcher needs the following files to run with Windows 3.1:
CALWIN16.DLL
CLNWIN16.DLL
CLXWIN16.DLL
LOCWIN16.DLL
NCPWIN16.DLL
NETWIN16.DLL
AUDWIN16.DLL

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Process to Set Up Application Objects
Install the software
After installing APPSNAP.DLL, the schema is modified to allow the NetWare* Administrator to 
create and define Application objects.
Create and define the Application object
An Application object is defined by its unique properties. Properties such as name, location 
of executable, and support contacts are assigned to each Application object.
An application may require unique drive mappings, printer ports, or environment variables. 
These specific variables must be specified in the application environment.
Assign Application objects to launch
Application objects may be assigned to users, groups, or containers.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Login script commands like If member of group=ACCT, then MAP F:=SYS/ACCT can be 
removed and configured when the application is launched.



The schema is a list of attributes that define an object and its relationship with other 
NetWare Directory Services objects. The schema exists at the root of the NetWare Directory 
Services tree. The NetWare Directory Services schema can be modified and expanded to suit
the specific needs of your organization.



 Set Up and Use Application Objects--Overview
Overview

What is an Application object
Why would I use Application objects
Setting up Application objects



 Set Up the NetWare Application Launcher--Overview
Overview
The NetWare* Application Launcher* allows users to run applications that were previously 
configured by a network administrator, and whose setup information is stored as an 
Application object in the NetWare Directory Services* tree.    NetWare Application Launcher 
displays icons for all available applications in a window, and lets the user double-click an 
icon to launch an application.
Users don't need to worry about drive mappings, paths, or rights--these are all managed by 
the network administrator. The administrator can manage the Application Launcher by 
container, Group, or User object.
Prerequisites
APPSNAP.DLL must be installed in the directory with NWADMIN.EXE.
The NetWare Administrator's NWADMIN.INI must include the path to the APPSNAP.DLL. See 
Install the Application object software.
Set up the NetWare Application Launcher
1. Install the software to the appropriate directories.
2. Configure the NetWare Application Launcher.
3. Assign Application objects to launch.
4. Make the NetWare Application Launcher available on the NetWare client workstation.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Set up the NetWare Application Manager--Overview
The NetWare* Application Manager consists of the following components.
1. Application objects 

Application object software allows the NetWare Administrator to create and define 
Application objects. The following files are installed and used with NetWare 
Administrator:

APPSNAP.DLL
APPRES16.DLL
APPSNAP.HLP

2. The NetWare Application Launcher
The NetWare Application Launcher software allows the user to launch applications. 
Although NAL.EXE is run by all client platforms, the following files are copied to an 
accessible directory on the network:

NAL.EXE (Administrators use NetWare Administrator and the snap-in (APPSNAP.DLL); 
users run NAL.EXE on all platforms).
NALW95.EXE (Windows 95** only)
NALW31.EXE (Windows 3.1** only)
NALRES32.DLL (Windows 95 only)
NALRES.DLL (Windows 3.1 only)
NALBMP32.DLL (Windows 95 only)
NALBMP.DLL (Windows 3.1 only)
NAL.HLP

The following files are needed for the NetWare Application Launcher to run on Windows 
3.1: 

AUDWIN16.DLL
CALWIN16.DLL
CLNWIN16.DLL
CLXWIN16.DLL
LOCWIN16.DLL
NCPWIN16.DLL
NETWIN16.DLL

The NetWare Application Launcher files should be installed in a network directory available 
to all network users. For example, you could install the files in the network directory SYS\
PUBLIC.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Set Up the Application Environment
Purpose
Some applications require custom configuration parameters to function properly. Before 
launching the application, the NetWare* Application Launcher* will configure the workstation
to properly run the application. The parameters, directories, mappings, and printer ports 
associated with the application will automatically execute. Upon exiting the application, the 
application post-termination script will remove any drive mappings or port captures it 
created upon execution.These mappings and captures don't actually happen until the user 
launches the application. 
The user can view (but not change) environment settings in the NetWare Application 
Launcher by choosing from the File menu Properties, then Resources.
Set up the application environment
1. Using the NetWare Administrator, choose the Application object from the NetWare 

Directory Services* tree.
2. From the Object menu, choose Details, then Environment.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Simplifies Administration of Network Applications
The NetWare* Application Manager works together with NetWare Directory Services* to 
simplify management of network applications by allowing administrators to centrally control 
Windows** desktops. Using NetWare Administrator, the NetWare Application Manager gives 
administrators the ability to create NetWare Directory Services objects that represent 
network-based applications.
Uses NetWare Directory Services to store information about the network 
applications
These objects contain information about where the network applications are physically 
located on the network and which users are authorized to use those applications. Network 
administrators can then use these objects to create a custom Windows program group for 
each Windows 3.x**, Windows 95**, or Windows NT** user on the network. 
Uses NetWare Directory Services to install and maintain network applications
Without leaving their workstation, administrators can deploy applications, managed through 
NetWare Directory Services, to user desktops across the network. This eliminates time-
consuming effort and significantly reduces installation costs of new network applications. 
Network administrators no longer have to travel to each user’s desktop to create a standard 
Windows program item for each application on the network. Instead, they use NetWare 
Directory Services to centrally administer and deploy network applications from the 
convenience of their own workstation.
Uses NetWare Directory Services to ensure security of network applications
Using the NetWare Application Manager, administrators can assign network applications by 
user, group, container, or any combination of the three. This makes setting up network 
applications on users’ Windows desktops quick and easy. Access to files and directories is 
handled through NetWare Directory Services file system security, ensuring that network 
security is maintained.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Simplifies User Access to Network Applications
Centralized graphical presentation of network applications
To access network applications, users run the NetWare* Application Launcher* from their 
Windows** Startup group or other Windows program group. This will present users with an 
NetWare Directory Services*-delivered set of network applications the administrator has 
assigned to them. To launch an application, a user simply double-clicks the appropriate icon 
in the group. The NetWare Application Manager does the rest, taking care of drive mappings 
and paths automatically. When using the NetWare Application Manager, standard Windows 
program items that represent network applications are no longer required and should be 
deleted from Windows desktops.
Access to network applications independent of login location
The NetWare Directory Services-delivered network applications are associated with a user’s 
network login ID, so they follow the user around the network. Regardless of the login 
location, the user always sees the same set of network applications. This ensures that 
people who work from multiple locations or physical workstations always have a consistent 
set of network applications.
Easy access to support information
For each NetWare Directory Services-delivered network application, the administrator can 
include a support number and e-mail address to use if help is required. This information is 
displayed in the properties of each application icon on the user’s desktop. The help 
information can be tailored so each user is directed to the support group for his or her 
location. The administrator can also specify that some network applications are to be 
launched automatically when the user runs the NetWare Application Manager. 

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Software and hardware requirements
Software requirements

Windows for Workgroups 3.11**, Windows 3.1**, Windows 95** or Windows NT**
NetWare* 4.1
NetWare Client* for DOS/Windows 1.2 (included with NetWare 4.1) or the new Client 32*-
based clients

Hardware requirements
There are no additional hardware requirements associated with running this program in a 
Windows environment.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Set up application support contacts
Purpose
The User objects designated as Application Contacts appear in the NetWare* Application 
Launcher** as resources for support. The end user may contact the assigned contact in 
person, phone, or use the Application Launcher to send an email.
Choose a user as an application contact
1. Using the NetWare Administrator, choose the Application object from the NetWare 

Directory Services* tree.
2. From the Object menu, choose Details.
3. Choose Contacts.
4. Choose Add or Delete.
5. Type or choose one or more User objects from the browser.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 Suggested Reading
Here is an overview of what you can find in this help file:

To get an introduction of what the NetWare* Application Manager can do for you, 
following the Overview of NetWare Application Manager links.
Before you do anything, read Prerequisites. Make sure you get a brief overview of the 
installation process and the files required in Setup and use the NetWare Application 
Manager.
When you are ready to create and define Application objects, read the links in the Set up
Application objects section. Don't forget to read the Overview.
Read the Overview in the Set up the NetWare Application Launcher* section before 
installing and configuring the NetWare Application Launcher. It will give you the big 
picture of the tasks required to manage and launch your applications.
Read up on how to use NetWare Application Launcher with many popular applications. 
Check out the Use the NetWare Application Launcher section. 
Finally, read through the Frequently asked questions & answers and View README file. 
These sections may be just the thing you are looking for.

If you have any suggestions about how to improve the documentation, please fax 
it to (801) 429-3002. Sorry, technical support is not available at this number.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.
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NetWare* supports the use of Universal Naming Convention (UNC) redirection for path 
statements in dialog boxes. UNC provides

The ability to use a network resource without setting up a drive mapping to it
The use of applications and programs within Windows** to access network volumes and 
directories
The ability to assign network applications, volumes, and directories to icons within 
Windows

An example of a valid UNC path is \\SERVER1\SYS\APPS\SOLITAIRE\SOL.EXE\.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 View README file
Readme for NetWare Application Launcher 1.0
 (c) Copyright 1996, Novell, Inc.    All rights reserved.
Overview
The NetWare* Application Launcher** allows users to run applications that were previously 
configured by a system administrator, and whose setup information is stored as an 
Application object in the NetWare Directory Services* tree.    NetWare Application Launcher 
displays icons for all available applications in a window, and lets the user double-click on an 
icon to launch an application.    Users don't need to worry about drive mappings, paths, or 
rights.    The administrator can manage the NetWare Application Launcher by container, 
Group, or User object.
Limitations and caveats
These limitations and caveats apply only to this release.

If a drive mapping exists, applications that need the drive letter with a different mapping 
will not execute. 
File system rights are not automatically granted when the Application object is assigned 
to a user, group, or container. These file system rights must be explicitly granted by the 
administrator. 
Caution should be used when setting the timed refresh setting. Frequent refreshes of 
large numbers of users can adversely impact network traffic. The default is timed refresh
= OFF. 
Changes to user configurations don't actually take place until the user closes the 
Application Launcher, and reruns it.    
The DLL that processes login scripts may not be available if a script is used with an 
Application object. You may need to move or copy the DLL to the WINDOWS\SYSTEM 
directory if it is not in the PATH. The DLL is LGNW9532.DLL on Windows 95** and 
LGNW3116.DLL on Windows 3.x**.

Creating application objects
To create an Application object in NetWare Directory Services, complete the following steps:
1. Run NetWare Administrator. (The Application Launcher snap-in should be installed and 

initialized.)
2. From the Object menu, choose Create.
3. Choose Application (Windows 95), Application (Windows 3.x) or Application 

(DOS) from the object list.
4. Specify the path of the application, using UNC or drive-letter syntax, in the application 

dialog box.
5. Choose Create to create the Application object.
6. (Optional) Choose the Environment page to specify any drive mappings or print captures 

that are needed for this application.
These mappings and captures don't actually happen until the user launches the 
application. When the user closes the application, the mappings and captures are 
removed. The user can view environment settings in the NetWare Application Launcher 
(but not change them) by choosing from the File menu Properties, then Resources.

7. (Optional) Specify a contact for the application.



Contact telephone numbers and e-mail names are available to users in the NetWare 
Application Launcher. The phone number and e-mail name are retrieved from the User 
object data in the tree.

Once the Application objects are created, you can associate them with User, Group, or 
container objects by doing the following: 
1. In NetWare Administrator, view details on the Container, Group, or User object you want 

to associate the Application object with.
2. Choose the Applications button. (This button is one of two new property buttons that 

appear at the bottom of the NetWare Administrator buttons after you have installed and 
initialized the Application Launcher snap-in.)

3. Add an Application object to the Applications to launch when the user selects list 
and the Applications to launch automatically list.
Applications in Applications to launch automatically are launched when the NAL.EXE 
file is executed. To launch applications in the Applications to launch when the user 
selects list, the user must double-click the icon.

4. Save the changes to the object.
The NetWare Application Launcher is updated as specified by the refresh rate. The 
default is no refresh. To change this refresh rate, in NetWare Administrator choose the 
Launcher Configuration page for that object and modify Refresh seconds.

ASSOCIATING APPLICATION OBJECTS WITH USERS
When the Application Launcher loads, it determines which applications to display for the 
user using the following algorithm: 

Display all applications associated with the User object
Display all applications associated with groups that the user belongs to
Display all applications associated with containers the user is part of (the number of 
containers to search is configured in the Launcher Configuration page of User objects 
and container objects)

Here are three scenarios and how they affect which applications the user sees:
Scenario #1 
Associations: WordPerfect* and Quattro Pro* are associated with the User object. 
User sees: WordPerfect and Quattro Pro.
Scenario #2 
Associations: User belongs to a group named PerfectOffice*. The PerfectOffice group has 
three applications associated with it: WordPerfect, Quattro Pro, and Presentations*. 
User sees: WordPerfect, Quattro Pro, and Presentations.
Scenario #3 
Associations: The context of the user is .CPT.NPD.NOVELL. The CPT container has an 
application named Schema Manager associated with it, NPD has GroupWise associated with 
it, and NOVELL has PhoneW associated with it. Container Levels in the Launcher 
Configuration page for the user is set to 2. 
User sees: Schema Manager and GroupWise*. User does not see PhoneW. 

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 View Application Objects Assigned to a User, Group, or 
Container
Purpose
Application objects assigned to a User, Group, or container object can be viewed using 
NetWare *Administrator. The Application objects can be assigned to launch when the user 
double-clicks the application icon, or can launch automatically when the NetWare Application
Launcher* is accessed.
To view the Application objects assigned to a user, group, or container
1. From NetWare Administrator, choose the User, Group, or container object.
2. From the Object menu, choose Details.
3. Choose Applications from the button bar.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 What Is the NetWare Application Launcher?
The NetWare* Application Launcher* displays icons for available network applications in a 
window, and lets the user double-click an icon to launch an application.
Users don't need to worry about drive mappings, paths, or rights; these are managed by the 
network administrator.
* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 What Is an Application Object?
An Application object is an extension to the NetWare* schema that allows network 
administrators to manage applications like other objects.
An Application object can only be used with NetWare Directory Services*.
Any DOS*, Windows*, Windows 95*, or Windows NT* executable can be designated as an 
Application object. Application object icons appear in the NetWare Directory Services tree 
and belong to a specific application class.

Application class
DOS
Windows 3.x**
Windows 95
Windows NT

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



 What is the NetWare Application Manager?
The NetWare* Application Manager allows network administrators to manage network 
applications as Application objects in the NetWare Directory Services* tree.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Topic outline
Application management
Application access & rights
Reduce drive mapping requirements
Reduce login time
Provide application information and support contacts



 Why Would I Use Application Objects?
With Application objects, you manage the network more efficiently, saving time and 
headaches administering applications. Application objects simplify administrative tasks such
as assigning rights, customizing login scripts, and supporting applications.
Application management
Using NetWare* Administrator, applications for an entire organization, group, or user can be 
centrally administered. By configuring executables as Application objects, you can perform 
upgrades and control versions of applications on the network more effectively.
Application access and rights
Assigning an Application object to a container, Group, or User object makes the application 
available to users who are trustees or members of those objects. Using the NetWare 
Application Launcher, the user can authenticate to the network anywhere and still access 
the same applications, regardless of the drive mappings and port captures of the local 
workstation.
Reduce drive mapping requirements in login scripts    example
When launching the application, network drive mappings, printer ports, and additional 
parameters can be automatically configured, reducing the need to add mappings in user 
login scripts to run network applications.
Reduce login time    example
Because Application objects configure their required resources when launched, maintenance
of system and user login scripts, as well as login execution times, can be reduced.
Provide application information and support contacts
Application parameters and support contacts can be assigned to each Application object. 
The application information is available to users on their desktops. Users can e-mail support 
contacts using the contact info associated with the application.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



These mappings and captures don't actually happen until the user launches the application. 
When the user closes the application, the mappings and captures are removed by default. 
The user can view (but not change) environment settings in the NetWare Application 
Launcher by choosing File, choosing Properties, and then choosing Drives/Ports.
Note: The default setting of an Application object is to clean up network resources when the
application has finished executing. This means successful mappings or captures are 
removed after the program closes, resulting in no mappings or captures for that port after 
execution.
Warning: If a drive mapping already exists, the NetWare Application Launcher mapping or 
port capture will fail.
Syntax for mapping a drive

SERVER\VOLUME:PATH
\\SERVER\VOLUME\PATH
VOLUME_OBJECT_NAME:PATH
DIRECTORY_MAP_OBJECT_NAME:PATH

Syntax for capturing a port
SERVER\DS_QUEUE_NAME:
\\SERVER\DS_QUEUE_NAME
DS_QUEUE_NAME
\\\DS_QUEUE_NAME
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